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1. Dilezite

1. Dulezité

Tato elektronickd uZivatelskd prirucka je
ur¢ena pro kazdého uZzivatele tohoto monitoru
Philips. Pred pouZivdnim monitoru si prectéte
tuto uZivatelskou prirucku. Obsahuje dulezité
informace a poznamky k pouzivani vaseho
monitoru.

Zaruka Philips je platnd, pokud je vyrobek
pouzivdn pro navrzenou potrebu v souladu

s ndvodem a po prilozen( origindlu faktury
nebo pokladnim dokladem, oznacujicim datum
ndkupu, jméno prodejce a modelové a vyrobnf
¢islo vyrobku.

1.1 Bezpecnostni opatreni a Udrzba

€ Varovani

Pouziti kontrol, Uprav nebo postupl jinym

zpUsobem nez je stanoveno v této dokumentaci

muZze vést k ohroZenf Sokem, elektrickym a/

nebo mechanickym rizikim.

Prectéte si a dodrzujte tyto instrukce pri

zapojovani a pouzivani vaseho PC monitoru.

Pouzivani

*  Nevystavujte monitor pffmému slune¢nimu
zdrenf, velmi silnym jasnym svétlim a
udrzujte jej mimo dosah jinych zdrojd tepla.
Dlouhé vystaveni tomuto typu prostredf

muze mit za ndsledek zménu barev a
poskozen{ monitoru.

»  Odstrarite veskeré predméty, které by
mohly spadnout do vétracich otvord nebo
zabranit dostatecnému chlazeni elektroniky
monitoru.

*  Nezakryvejte vétracl otvory ve skiiice.

*  Umlistéte monitor na takové misto, ze
kterého bude elektrickd zdstrcka a zdsuvka
snadno pristupna.

* Jestlize jste vypnuli monitor odpojenim
napdjectho kabelu nebo kabelu napdjeciho
adaptéru, pred pripojenim kabelu pockejte
6 sekund, aby monitor fungoval normdiné.

* Vzdy pouzivejte napdjeci kabel schvéleny
spole¢nosti Philips. Pokud napd jeci kabel
chybi, obratte se na nejblizs servisnf
stredisko. (Viz informace o strediscich
zdkaznické péce)

*  Béhem pouZivdni nevystavujte monitor
nadmémym otrresim nebo ndrazim.

*  Pri pouzivdni nebo premistovani do
monitoru nekopejte a zabrarte pripadnému
péadu.

Udrzba

*  Aby byl monitor chrdnén pred moznym
poskozenim, nevyvijejte na panel LCD
nadmeémy tlak. Pri premistovani zvedejte
monitor za rdm; pri zveddni monitoru
nesahejte rukou nebo prsty na panel LCD.

* Nebudete-li monitor dels{ dobu pouzivat,
odpojte jej ze zasuvky.

* Pred ocisténim mime navihéenym
hadrfkem monitor odpojte ze zdsuvky.
Je-li vypnuté napdjent, Ize obrazovku otrit
suchym hadrikem. K &isté&ni monitoru nikdy
nepouzivejte organickd rozpoustédla, jako
napfiklad alkohol nebo Cistice s obsahem
¢pavku.

» Zabrarite nebezped( Urazu elektrickym
proudem nebo trvalého poskozenf
monitoru a chrarite monitor pried prachem,
destém, vodou nebo nadmérmé vihkym
prostredim.

* Pokud dojde k namoceni monitoru, co
nejdrive jej osuste suchym hadrkem.

*  Vnikne-li do monitoru cizf ldtka nebo voda,
ihned vypnéte napdjeni a odpojte napdjecl
kabel. Odstrarite cizf ldtku nebo vodu
z monitoru a odeslete jej do servisniho
strediska.

*  Monitor neskladujte ani nepouzivejte
na mistech vystavenych teplu, primému
slune¢nimu zdreni nebo extrémnim
teplotdm.

*  Chcete-li zachovat optimdlni vykonnost
monitoru a prodlouZit jeho Zivotnost,
pouZivejte jej na misté, které splfiuje
nasledujici rozsahy teplot a vihkosti.



1. Dilezit

* Teplota: 0-40°C 32-95°F
*  Vlhkost: 20-80% relativni vihkosti

DULEZITE: Pfed ponechanim monitoru
bez dozoru vzdy aktivujte sporic obrazovky.
Bude-li na vasem monitoru zobrazen
nemeénici se staticky obsah, vzdy aktivujte
aplikaci pro pravidelnou obnovu obrazovky.
Dlouhodobé neprerusované zobrazenf
nehybného nebo statického obrazu mize
zpusobit , vypaleni obrazovky, rovnéz
zndmé jako ,dosvit" nebo ,,zobrazeni
duchd.

,Vypdleni*, ,dosvit" nebo ,,zobrazen{
duchl'" je dobre zndmy jev u technologie
paneld LCD. V mnoha pripadech , vypélent”,
,, dosvit" nebo ,zobrazeni duchd" postupné
zmizf po urcité dobé mimo provoz.

) Vystraha

Véazné priznaky ,vypdleni*, , dosvitu" nebo
,,zobrazenf duchd' nezmizf a nelze je opravit. Na
vyse uvedené poskozen( se nevztahuje zdruka.

Servis

Kryt pldsté maze oteviit pouze kvalifikovany
servisni pracovnik.

Pokud je pro opravu vyZadovdna
dokumentace nebo integrace, obrat'te se
na nejblizsi servisnf stredisko. (Viz kapitola
, Stredisko zakaznické péce')

Informace o preevézeni najdete v Casti

,, Technické Udaje".

Neponechévejte monitor v auté nebo v
zavazadlovém prostoru auta na primém
slunci.

© Poznimka

Pokud monitor nefunguje spravné nebo pokud
si nejste jisti, jaké kroky je tr'eba provést po
proveden( pokynU v této prirucce, obratte se na
servisntho pracovnika.

1.2 Vysvétleni zapisu

Nasledujici pododdily popisujf zplsob zdpisu,
ktery se pouzivad v této prirucce.

Poznamky, upozornéni a vystrahy

Na strdnkdch této prirucky mizete narazit na
text, ktery je opatfeny symbolem a je vytistén
tucné nebo kurzivou. Takové useky obsahujf
poznamky, upozornéni a vystrahy. Jejich pouzitf
je nasledujict:

© Poznimka

Tento symbol oznacuje dllezité informace a
ndvrhy, které poméhajf Iépe vyuzit pocitacovy
systém.

© Upozornéni

Tento symbol oznacuje informace, které
objasniujf, jak se vyhnout moznému poskozenf
zafizeni nebo ztrdté dat.

D Vystraha

Tento symbol oznacuje nebezped( télesného
ubliZzenf a vysvétluje, jak se danému problému
vyhnout.

Nekteré vystrahy se mohou objevit v rizné
podobg a nemusi byt uvozeny symbolem.V
takovém pripade je konkrétni vyznacenf vystrahy
nar{zeno Uradem pro regulaci.
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1.3 Likvidace produktu a obalového
materialu

Likvidace elektrickych a elektronickych
zarizeni - WEEE

This marking on the product or on its
packaging illustrates that, under European
Directive 2002/96/EC governing used electrical
and electronic appliances, this product may
not be disposed of with normal household
waste.You are responsible for disposal of

this equipment through a designated waste
electrical and electronic equipment collection.
To determine the locations for dropping off
such waste electrical and electronic, contact
your local government office, the waste disposal
organization that serves your household or the
store at which you purchased the product.

Your new monitor contains materials that can
be recycled and reused. Specialized companies
can recycle your product to increase the
amount of reusable materials and to minimize
the amount to be disposed of.

All redundant packing material has been
omitted. We have done our utmost to make the
packaging easily separable into mono materials.

Please find out about the local regulations on
how to dispose of your old monitor and packing
from your sales representative.

Recycling Information for Customers

Your display is manufactured with high quality
materials and components which can be
recycled and reused.

To learn more about our recycling program
please visit www.philips.com/about/sustainability/

recycling.




2. Sestaveni monitoru 2] Namontujte stojanek podstavce
: 1. Umistéte monitor obrazovkou dold na

meékky a hladky podklad, aby nedoslo k
poskrabdni obrazovky.

2.1 Instalace

El Obsah krabice

%%art

PHILIPS

2. Uchopte monitor obéma rukama a
pripevnéte stojdnek podstavce do sloupku
podstavce.

(1) Opatmeé pripevnéte podstavec ke
sloupku podstavce tak, aby zdpadka
zajistila podstavec.

(2) Prsty utdhnéte Sroub na spodnf strané
podstavce a pevné zajistéte podstavec
ke sloupku.

DVI (nepovinny)

VGA (nepovinny)




El Pripojeni k poitadi

PHILIPS
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© Vstup stiidavého napdjent
© VstupVGA
© Vstup DVI-D (k dispozici pro vybrané

modely)

@ Zimek proti krddeZi Kensington

Pripojeni k pocitaci

1.

Pevné pripojte napdjeci kabel k zadnf strané
monitoru.

Vypnéte pocitac a odpojte jeho napdject
kabel.

Pripojte signdlovy kabel monitoru do video
konektoru na zadnf strané pocitace.
Zapojte napdjeci kabel pocitace a monitoru
do nejblizsi zasuvky.

Zapnéte pocfta¢ a monitor: Jestlize se

na monitoru objevi obraz, instalace je
dokoncena.

2.2 Ovladani monitoru

El Popis vyrobku z Eelniho pohledu
190E3L:

190E3L (pro model 1A):

|
7]
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[\ | |

Slouzi k ZAPNUT( a VYPNUT(
napdjeni monitoru.

&/0K

Slouzi ke vstupu do nabidky
Osh.

Slouzi k ndvratu na predchozf
drovens OSD.

Zména formétu zobrazeni.

Nastaven( drovné jasu.

Slouzi k Upravdm nabidky OSD.

© 6 6 o0 o o

Slouzi ke zméné zdroje
vstupniho signalu.

Zména formdtu zobrazen.

<
fof
AV
2)
ff
iy

Smartimage Lite Lze vybrat
néktery ze Sesti rezimd: Standard
(Standardni), Internet a Game (Hra).




2. Sestaveni monitoru |
2] Popis zobrazeni funkci na obrazovce

Co je nabidka na obrazovce (OSD)?

Funkcf nabidky obrazovky (On-Screen Display,
OSD) jsou vybaveny viechny monitory

LCD Philips. Umozniuje koncovému uzivateli
upravovat vlastnosti obrazovky nebo vybirat
funkce monitoru primo prostrrednictvim
zobrazeného okna s pokyny. NiZe je uveden
priklad prfjlemného rozhrani obrazovky:

190E3L:

Zakladni a jednoduché pokyny k ovladacim
tladitkim

Ve vySe uvedené nabidce obrazovky OSD
muZete stisknutim tlacftek ¥ A na prednim
rdmecku monitoru pohybovat kurzorem a
stisknutim OK potvrdit vybér nebo zménu.

Nabidka OSD
NiZe je uveden celkovy pohled na strukturu
OSD. Tento prehled mlzete vyuzit, budete-li
chtit pozdé&ji prozkoumat rliznd nastavent.

Main menu

— Input

— Picture

— Color

— Language

— OSD Settings

L— Setup

Sub menu

L

VGA

DVI (available for selected model)

Picture Format —
Brightness -
Contrast —

SmartContrast —

Color Temperature ——
sRGB

User Define

Wide Screen, 4:3
0~100

0~100

On, Off

6500K, 9300K

Red: 0~100
Green: 0~100

Blue: 0~100

English . Espafiol, Francais, Deutsch, Italiano,

Portugués, Pycckuin, AL, Tirkge

Horizontal -
Vertical —
Transparency —

OSD Time Out -

Auto
Power LED
H. Position
V. Position
Phase
Clock

Resolution Notification

Reset

Information

0~100
0~100
Off,1,2,3,4

5s, 10s, 20s, 30s, 60s

— 0,1,2,3,4
— 0~100
— 0~100
— 0~100
— 0~100
— On, Off
— Yes, No



El Poznamka k rozliseni 2.3 Odpojte stojanek podstavce a
Tento monitor je urcen pro optimdlni vykon podstavec

pri nativnim rozliseni 1440 x 900 pri 60 Hz.

KdyZ je monitor zapnut pfi jiném rozlideni, na Il Demonta# stojanku podstavce

obrazovce se zobrazi vystraha: Pro optimdlnf Nez zacnete demontovat podstavec monitoru,
vysledek pouZijte rozliseni 1440 x 900 pfi postupujte podle pokyni nize, aby se zabranilo
60 Hz. jakémukoli moznému poskozeni nebo zranént.
Zobrazovén( vystrahy na nativni rozligenf Ize 1. Umistéte monitor obrazovkou doli na
vypnout v &asti Setup (Nastaven() v nabidce mékky podklad, aby nedoslo k poskrdbani
OSD. obrazovky.

Bl Fyzické funkce
Naklon

2. Podle nésledujicich pokynl oddélte stojanek
podstavce od sloupku podstavce:

(1) Prsty uvolnéte Sroub na spodnf strané
podstavce.

(2) Opatmymi pohyby nahoru a dold
uvolnéte zdpadku, kterd zajistuje
podstavec, a stdhnéte podstavec ze
sloupku.
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E Demontaz podstavce

1. Mdzete zasunout plochy Sroubovak do
dvou uvolfovaci otvord na krytu zdvésu a
jemnym pacenim jej odstrarite.

2. Odmontujte 4 Srouby a potom sejméte
podstavec z monitoru.




3. Optimalizace Obrazu

3.1 Smartimage Lite

El Cojeto?

Funkce Smartimage Lite nabizi scéndre, které
optimalizujf zobrazenf rdznych typd obsahu a
dynamicky zlepSuje jas, kontrast, barvy a ostrost
v redlném case. Funkce Philips Smartimage Lite
prindsf optimalizované zobrazeni monitoru

bez ohledu na to, zda pracujete s aplikacemi,
prohlizite obrdzky nebo sledujete video.

Bl Prog to potiebuii?

Protoze chcete sledovat monitor, ktery

prindsi optimalizované zobrazeni viech vasich
oblibenych typl obsahu. Software Smartimage
Lite dynamicky upravuje jas, kontrast, barvy a
ostrost v redlném case pro dosazeni nejlepsiho
zdzitku ze sledovani monitoru.

E Jak to funguje?

Smartlmage Lite exkluzivni Spickovd technologie
spole¢nosti Philips, kterd analyzuje obsah
zobrazeny na obrazovce. Na zdkladé vami
zvoleného scéndre technologie Smartimage

Lite dynamicky zlepSuje kontrast, sytost barev

a ostrost obrazu pro vylepSeni zobrazovaného
obsahu — ve v redlném case stisknutim jediného
tlacitka.

B3 Jak aktivovat Smartlmage Lite?

1. Stisknutim B se Smartlmage Lite zobrazf
na obrazovce;

2. Opakovanym stisknutim B} miZete prepinat
mezi rezimy Standard (Standardni), Internet,
Game (Hra).

3. Zobrazeni Smartlmage Lite zUstane na
obrazovce po dobu 5 sekund nebo mUzete
rovnéz potvrdit stisknutim tlacitka OK.

4. Po aktivaci technologie Smartimage Lite je

automaticky deaktivovano schéma sRGB.
Aby bylo mozné pouzit schéma sRGB, je
treba deaktivovat funkci Smartlmage Lite
stisknutim tlacftka B2 na prednim panelu
monitoru.

Kromé tlacitka BI? pro posun doll mizete
rovnéz provést vybér stisknutim tlacitek w a

, potvrdit vybér stisknutim tlacitka OK a ukoncit
nabidku Smartimage Lite OSD.

Lze vybrat néktery ze Sesti rezimd: Standard
(Standardn), Internet, Game (Hra).

@ Smartimage '™

Standard

Internet

*  Standard (Standardni): Vylepsuje text a
snizuje jas pro zvysenf Citelnosti a omezenf
namahdni zraku. Tento rezim podstatné
zvysuje Citelnost a produktivitu pri praci
s tabulkami, soubory PDF, skenovanymi
¢lanky nebo jinymi obecnymi kanceldrskymi
aplikacemi.

e Internet: Tento profil kombinuje vylepsen(
sytosti barev, dynamického kontrastu a
ostrosti pro zobrazenf fotografif a dalsich
obrdzkd s vynikajici Cistotou v Zivych
barvach — to vie bez artefaktl a vybledlych
barev.

*  Game (Hra): Tento profil prindsi nejlepsi
hemf z&Zitek pro hrdce, protoze aktivuje
prebuzeny okruh pro optimdlni dobu
odezvy, omezeni zubatych okrajd rychle
se pohybujicich objektd na obrazovce a
vylepsen( kontrastniho poméru pro jasné a
tmavé scény.
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3.2 SmartContrast

El Cojeto?

Jedine¢nd technologie, kterd dynamicky analyzuje
zobrazeny obsah a automaticky optimalizuje
kontrastni pomér monitoru LCD pro maximdlnf
vizudinf Cistotu a pozitek ze sledovéni. Zvysuje
podsviceni pro jasnéjsi, ostrejsi a jasnéjsi obraz
nebo snizuje podsviceni pro jasné zobrazenf
obrazu s tmavym pozadim.

E1 Pro¢ to potfebuii?

Zéadate nejvy3 vizudlni gistotu a pohodli
sledovén( jakéhokoli typu obsahu. SmartContrast
dynamicky r{df kontrast a upravuje podsvicenf
pro jasné, ostré a jasné zobrazen( her a videa
nebo pro zobrazenf jasného, Citelného textu
pro kanceldrskou praci. Omezenim spotreby
monitoru Setrfte ndklady a prodluzujete Zivot
vaseho monitoru.

E Jak to funguje?

Po aktivaci bude funkce SmartContrast v
redlném case analyzovat zobrazeny obsah a
upravovat barvy a ridit intenzitu podsvicenf. Tato
funkce bude dynamicky vylepSovat kontrast pro
skvély zazitek pri prohlizenf fotografif nebo hrani
her.

3.3 Philips SmartControl Lite

Novy software SmartControl Lite od
spolec¢nosti Phillips umozriuje ovlddat monitor
prostrednictvim snadno pouzitelného grafického
rozhrani na obrazovce. Slozitd nastaven( jsou
minulosti, protoZe tento uzivatelsky prijemny
software vds provede jemnym vyladénim
rozlideni, kalibraci barev, nastavenim frekvence/
fdze, nastavenim bilého bodu RGB atd.

Tento software zalozeny na pritazlivych
animovanych ikondch kompatibilnf se systémem
Windows 7, ktery je vybaven nejnovejsi
technologil v jddrovém algoritmu pro rychlé
zpracovan( a odezvu, je pripraven rozsftit vasi
zkudenost s monitory Philips!

El Instalace

10

Postupuijte podle pokynl a dokoncete
instalaci.

MdZete spustit po dokoncenf instalace.
Chcete-li spustit pozdéji, mizete klepnout
na zdstupce na pracovni plose nebo na
panel nastroju.

PHILIPS e g e piczrre

Prvni spusténi —Wizard (Privodce)

Pri prvnim spusténi po instalaci prejde
SmartControl Lite automaticky na Wizard
(Pravodce).

Tento prdvodce vds provede podrobnym
nastavenim vykonu monitoru.

Privodce mlzete rovnéz spustit pozdéji z
nabidky Plug-in (Zasuvny modul).

Dal8f moznosti mlzete nastavit bez
privodce prostrednictvim podokna
Standard (Standardni).

<] trtrarei Liw 1

PHILIPS

SmartControl Lite

Wizard

]

Adhst

s




3. Optimalizace Obrazu

E1 Spusténi s podoknem Standard (Standardni): [Fi o
SmartControl Lite PHILIPS

Nabidka Adjust (Nastaveni):

* Nabidka Adjust (Nastaveni) umozriuje
upravit Brightness (Jas), Contrast (Kontrast),
Focus (Ohnisko), Position (Poloha) a
Resolution (Rozligeni).

*  MulzZete postupovat podle pokynd a provést
nastavent.

*  Cancel (Storno) vyziva uzivatele, chcete-li
ukonit instalaci.
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3. Optimalizace Obrazu
Nabidka Color (Barva):

Nabidka Color (Barva) umoZniuje upravit
RGB, Black Level (Urovef erné), White
Point (Bily bod), Color Calibration (Kalibrace
barev) a Smartlmage Lite (viz ¢ast
Smartimage Lite).

MUzZete postupovat podle pokynt a provést
nastavent.

V ndsledujici tabulce vyhledejte polozku
podnabidky na zdkladé vaseho vstupu.
Priklad pro Color Calibration (Kalibrace
barev)

p—

SmartControl Ut®

x|
PHILIPS

e
o] = o &
% White Port [ »
R
. bt mda asar
(= @ = BT
! smmtivage
| ] st e J_; 1
| SmartControl ¢ PHILIPS |
i ]
p— s
g- 2.
- 'g- ta Fur S
I —
e
! Srurtirag 1
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6.

[E—r

-

SmartControl 1* PHILIPS

Calibration

=
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e
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g e _ wm
s

Tlacitko ,,Show Me" (Predvést) spustf
vyukovy program pro kalibraci barev.

Start (Spustit) — zahdjf sekvenci kalibrace
barev o 6. krocich.

Quick View (Rychlé zobrazeni) nacte
zobrazeni pred/po.

Chcete-li se vratit na hlavni stranku Color
(Barva), klepnéte na tlacitko Cancel (Storno).
Enable color calibration (Povolit kalibraci
barev) — ve vychozi konfiguraci je zapnuto.
Pokud tato polozka nenf zaskrtnuta, kalibraci
barev nelze provést a tlacitka rychlé
zobrazeni nejsou k dispozici.

Na kalibracni obrazovce musf byt zobrazeny
informace o patentech.

Calibration Screen (Obrazovka kalibrace)
prvni barvy:

Tlacftko Previous (Predchozi) je
deaktivovdno az na obrazovku druhé barvy.
Tlacitko Next (Dalsi) slouzi k prechodu na
nasledujici cil (6 cild).

Tlacitko Konecny slouzi k prechodu na File
> Presets (Soubor > podokno Predvolby).



3. Optimalizace Obrazu

»  Tlacitko Cancel (Storno) slouzi k ukoncent
uZivatelského rozhranf a k ndvratu na
strdnku zdsuvnych moduld plug-in.

Smartlmage Lite

Smartimage — umozriuje uzivateli zménit
nastaven( pro vylepSenf zobrazenf na zdkladé
obsahu.

Kdyz je nastavena moznost Entertainment
(Zabava), jsou polozky SmartContrast a
SmartResponse k dispozici.

g [ —— 7%

SmartControl Lite PHILIPS
Smartimage
= .
X a
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Options>Preferences (Moznosti>Predvolby)
— Tato moznost bude aktivni pouze po
vybéru polozky Preferences (Predvolby) v
rozeviraci nabidce Options (MoZznosti). Na
nepodporovaném zobrazovacim zafizenf s
podporou DDC/Cl jsou k dispozici pouze karty
Help (Ndpovéda) a Options (Moznosti).
(e T

SmartControl ¢ PHILIPS

Prefesences

Adpat

-
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* Zobrazf nastaven( aktudinich predvoleb.

»  Zaskrtnuté tlacitko aktivuje funkci.
Zaskrtdvaci policko je prepinac.

* Polozka Enable Context Menu (Povolit
mistni nabidku) na pracovni plose je ve
vychoz( konfiguraci zaskrtnutd (Zapnuto).
Po aktivaci polozky Enable Context
Menu (Povolit mistni nabidku) se zobrazf
vybéry SmartControl Premium pro funkce
Select Preset (Vybrat predvolbu) a Tune
Display (Ladéni zobrazeni) na pracovnf
plose klepnutim pravym tlacitkem mysi na
mistni nabidku. Volbou moZznosti Disabled
(Deaktivovdno) bude polozka SmartControl
Premium odstranéna z mistni nabidky
pravym tlacitkem mysi.

» PoloZka Enable Task Tray (Povolit ikonu na
hlavnim panelu) je ve vychozi konfiguraci
zaskrtnutd (Zapnuto). Po aktivaci polozky
Enable Context Menu (Povolit mistnf
nabidku) se zobrazf nabidka SmartControl
Lite na hlavnim panelu. Klepnutim pravym
tlacitkem mysi na ikonu na hlavnim panelu se
zobrazi moznosti nabidky Help (Ndpovéda),
Technical Support (Odbormd pomoc),
Check for Update (Vyhledat aktualizace),
About (O aplikaci) a Exit (Konec). Kdyz
je deaktivovdna poloZzka Enable task tray
menu (Povolit nabidku na hlavnim panelu),
ikona na hlavnim panelu zobrazuje pouze
moznost EXIT (KONEC).

* Polozka Run at Startup (Spustit pri startu) je
ve vychoz( konfiguraci zaskrtnutd (Zapnuto).
Kdyz je tato polozka deaktivovdna, funkce
SmartControl Lite se nespustf pri startu
nebo nebude na hlavnim panelu. Funkci
SmartControl Lite Ize spustit pouze
prostrednictvim zdstupce na pracovni
plose nebo prostrednictvim souboru
programu. Kdyz toto policko nenf zaskrtnuté
(Deaktivovdno), zddnd preedvolba nastavend
pro spusténi pri startu nebude nactena.

* Enable transparency mode (Aktivovat rezim
prihlednosti) (Windows 7, Vista, XP).
Vychozi nastaveni je O % neprdhlednost.

Options>Input (Moznosti>Vstup) — Tato
moznost bude aktivn pouze po vybéru
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polozky Input (Vstup) v rozeviraci nabidce
Options (Moznosti). Na nepodporovaném
zobrazovacim zafizeni's podporou DDC/CI
jsou k dispozici pouze karty Help (Ndpovéda)
a Options (Moznosti). Zadné dal3f karty funkce
SmartControl Lite nejsou k dispozici.

SmartControl Lite PHILIPS

Input

F

ggUD

Ansiog in Dgtal

* Zobrazi podokno s pokyny Source (Zdroj)
a nastaven( aktudlniho zdroje vstupu.

* U zobrazovacich zafizenf s jednim vstupem
neni toto podokno zobrazeno.

Options>Audio (Moznosti>Zvuk) — Tato

moznost bude aktivni pouze po vybéru polozky

Audio (Hlasitost) v rozeviraci nabidce Options

(Moznosti).

Na nepodporovaném zobrazovacim zafizen( s

podporou DDC/Cl jsou k dispozici pouze karty

Help (Napovéda) a Options (MoZnosti).

eSS T

SmartControl Lite PHILIPS

Auvdio

Help>User Manual (Napovéda>Uzivatelska
prirucka) —Tato moznost bude aktivni pouze
po vybéru polozky User Manual (Uzivatelska
prirucka) v rozeviraci nabidce Help (Ndpovéda).
Na nepodporovaném zobrazovacim zarizen( s
podporou DDC/Cl jsou k dispozici pouze karty
Help (Napovéda) a Options (MoZnosti).

PHILIPS

SmartControl Lite

User Manual
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Help>Version (Napovéda>Verze) —Tato
moznost bude aktivni pouze po vybéru
polozky Version (Verze) v rozeviraci nabidce
Help (Napovéda). Na nepodporovaném
zobrazovacim zarizeni s podporou DDC/CI
jsou k dispozici pouze karty Help (Ndpovéda) a
Options (Moznosti).

ot e ix

SmartControl Lite PHILIPS

Version
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Context Sensitive menu (Mistni nabidka)
Context Sensitive Menu (Mistni nabidka) je ve
vychoz( konfiguraci Aktivovdna. Nabidka bude
zobrazena po zaskrtnutf polozky Enable Context
Menu (Povolit mistni nabidku) v ¢asti Options

> podokno Preferences (Moznosti > podokno
Predvolby).

D SmartControl

Select Preset L4

Context Menu (Mistni nabidka) obsahuje ctyfi

polozky:

*  SmartControl Lite - po vybéru se zobrazf
obrazovka About (O) aplikaci.

*  Select Preset (Vybrat predvolbu) — nabizf
hierarchickou nabidku ulozenych predvoleb
pro okamzité pouziti. Aktudlné vybrand
predvolba je oznacena zaskrtnutim. V
rozeviraci nabidce Ize rovnéz vybrat polozku
Predvolby vyrobce.

» Tune Display (Ladéni zobrazeni) — otevre
ovlddaci panel SmartControl Lite.

*  Smartimage Lite — zkontrolujte aktudlnf
nastaven( Standard (Standardn), Intemet,
Game (Hra).

Aktivovana nabidka hlavniho panelu

Nabidku hlavniho panelu Ize zobrazit klepnutim
pravym tlacitkem mysi na ikonu SmartControl
Lite na hlavnim panelu. Klepnutim levym
tlacitkem lze spustit aplikaci.

Help

Technical Support
Check for Update
About

Exik

Hlavni panel obsahuje pét polozek:
* Help (Ndpovéda) — pristup k souboru
s User Manual (uzivatelskou priruckou):

Otevre soubor s User Manual (uzivatelskou
priruckou) v okné vychoziho prohlizece.

* Technical Support (Odbornd pomoc) —
zobrazf strdnku odborné pomoci.

*  Check for Update (Vyhledat aktualizace) —
zobraz{ Uvodn( stranku PDI a porovna verzi
uzivatele s nejaktudlngjsi dostupnou verz.

* About (O aplikaci) — zobrazf podrobné
referencni informace: verze produktu,
informace o vyddni a ndzev produktu.

*  Exit (Konec) - ukon¢i SmartControl Lite

Chcete-li znovu spustit funkci SmartControl Lite,
vyberte polozku SmartControl Lite z nabidky
Program, poklepejte na ikonu na pracovni plose

pocitae nebo restartujte pocital.

PHILIPS

SmartControl

2010 MWD

Powered by Display Tune(R)
AllRights Ressrved

Copyright of Suppliers Acknowledged

Deaktivovana nabidka hlavniho panelu

Kdyz je hlavni panel deaktivovan ve slozce
Preference (Predvolby), je k dispozici pouze
cast EXIT (KONEC). Chcete-li funkci
SmartControl Lite zcela odstranit z hlavniho
panelu, deaktivujte polozku Run at Startup
(Spustit pri startu) v casti Options>Preferences
(Moznosti>Predvolby).



4. Technické udaje

Typ panelu LCD TFT-LCD

Podsvicenf LED

Velikost panelu 19" S (48,26cm)

Pomér stran 16:10

Rozte¢ obrazovych bodu 0,2835 x 0,2835 mm

Jas 250 cd/m?

SmartContrast 20.000.000:1

Kontrastni pomér (typ.) 1000:1

Doba odezvy (typ.) 5ms

Optimdln{ rozlisenf 1440 x 900 pri 60 Hz

Zory Uhel 170° (H) / 160° (V) pri C/R>10

VylepSeni obrazu Smartimage Lite

Barevnost displeje 16,/ M

Vertikdlni obnovovaci frekvence | 56 Hz — 76 Hz

Horizontdlni frekvence 30 kHz — 83 kHz

sRGB ANO

Vstup signdlu DVI (digitdlni), VGA (analogovy)

Vstupnf signal Oddélend synchronizace, synchronizace podle zelené

Usnadnénf pro uzivatele 190E3L: /v ©/A /< /0K 0]
190E3L(1A): Ep/v /A 0/ 4 B/0K 0}

Jazyky nabidky OSD anglictina, francouzstina, némcina, italstina, rustina, Spanélstina,
zjednodusend ¢instina, portugalstina, turectina

Dalsi usnadnénf Z3amek Kensington

Kompatibilita s technologif DDC/CI, sRGB, Windows 7/Vista/XP, Mac OSX, Linux

Plug & Play

Néklon -5/+20

Zapnuto 17,77W (typ.), 18,98W (max.)

Spotreba energie (Metoda Stridavé vstupni Stridavé vstupni Stridavé vstupnf

testovani EnergyStar 5.0) napéti pri 100 VAC | napéti pri 115 VAC | napéti pri 230 VAC
+/-5 VAC, 50 Hz | +/-5 VAC, 60 Hz +/-5 VAC, 50 Hz
+/-3 Hz +/-3 Hz +/-3 Hz

Normdlni provoz (typ.) 14,5W 14,4W 14,37W

Spanek 0,5W 0,5W 0,5W

Vypnuto 0,5W 0,5W 0,5W

Rozptyl tepla* Stridavé vstupni Strfdavé vstupnf Stridavé vstupnf
napéti pri 100 VAC | napéti pri 115 VAC | napéti pri 230 VAC
+/-5 VAC, 50 Hz | +/-5 VAC, 60 Hz +/-5 VAC, 50 Hz
+/-3 Hz +/-3 Hz +/-3 Hz
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4.Technické adaje

BéZny provoz 49,49 BTU/hod 49,15 BTU/hod 49,04 BTU/hod
Spdnek 1,71 BTU/hod 1,71 BTU/hod 1,71 BTU/hod
Vypnuto 1,71 BTU/hod 1,71 BTU/hod 1,71 BTU/hod
Indikdtor napdjenf Zapnuto: Bild, Pohotovostni rezim/rezim spanku: Bild (blikd)
Napdjenf Vypdleni, 100-240VAC, 50-60Hz

Vyrobek s podstavce (5xVxH) 463,59 x 390,93 x 199,8 mm

Vyrobek bez podstavee (SxVxH)

463,59 x 320,46 x 41,1 mm

Prohldseni o shodé

Barva

Vyrobek s podstavcem 3,19kg

Vyrobek bez podstavce 2,8kg

Vyrobek s obalem 4,45kg

Teplotn( rozsah (provoz) 0°C az 40 °C

Teplotni rozsah (mimo provoz) -20°C az 60°C

Relativni vihkost 20% az 80%

Nadmorskd vyska Pouzirdnf: + 12 000 stop (3 658 m)
Mimo provoz: + 40 000 stop (12 192 m)

MTBF 30 000 hod.

ROHS ANO

EPEAT Silver (www.epeat.net)

Balenf 100% recyklovatelny

CE Mark, FCC Class B, GOST, SEMKO, TCO Certified, UL/cUL,
BSMI, 1SO9241-307

Cernd (zadnf &ast), modrd (prrednf ¢dst)

Povrchova Uprava

Leskld

© Poznimka

1. Certifikdt EPEAT Gold nebo Silver je platny pouze tam, kde spolec¢nost Philips zaregistruje produkt.
Informace o stavu registrace ve vasi zemi viz www.epeat.net.
2. Tyto Udaje se mohou zménit bez predchoziho ozndment. Stéhnéte si nejnoveéjsi verzi letdku z webu

www.philips.com/support.

17




4.Technické adaje

4.1 Rezimy rozliseni a predvoleb

E Maximalni rozliseni
1440 x 900 pri 60 Hz (analogovy vstup)
1440 x 900 pii 60 Hz (digitdni vstup)

B3 Doporucené rozliseni
1440 x 900 pii 60 Hz (digitdlnf vstup)

480i [720 x 480 SD |60
480p (720 x 480 SD |60
5761 [720 x 576 SD |50
576p |720 x 576 SD |50
720p (1280 x 720 HD |50, 60
1080i (1920 x 1080 | HD |50, 60
1080p {1920 x 1080 | HD |50, 60
@ Poznamka

Upozomiujeme vds, ze tento monitor funguje
nejlépe pri nativnim rozliseni 1440 x 900 pri

60 Hz. Pro dosazen( optimalni kvality zobrazenf

dodrzujte toto doporucené rozlisen.

18



5. Rizeni spotreby

Pokud je v daném pocitaci nainstalovan software
nebo videokarta vyhovujici normé DPM
organizace VESA, monitor dokdze automaticky
snizit svou spotrebu energie, neni-li pouzivan.
Pokud pocfta¢ rozpoznad vstup z kldvesnice,

my3i nebo jiného vstupniho zaffzenf, monitor se
automaticky ,,probudf*. Ndsledujici tabulka uvadf
spotrebu energie a signalizaci této funkce pro
automatickou Usporu energie:

Rezim VESA | Video |H-synch. | V-synch.| Spotreba energie |Barva indikdtoru LED
Adivni | zaP. | Ao | Ao | ST77TW B4
(typ)
Spdnek VYP. Ne Ne <05 W (typ) Bild (blikd)
Vypnuto VYP. - - <05W (typ.) VYP.

Ndsledujic konfigurace se pouziva pri mérenf
energetické spotreby tohoto monitoru.

*  Nativni rozliseni: 1440 x 900

*  Kontrast: 50%

e Jas: 250 nitd

» Barevnd teplota: 6500 K s pIné bilym
vzorkem

& Poznimka
Tyto Udaje se mohou zménit bez predchoziho
ozndment.
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6. Informace o regulaci

6. Informace o regulaci

Lead-free Product

Lead free display promotes
environmentally sound recovery

@ and disposal of waste from electrical
and electronic equipment. Toxic
substances like Lead has been eliminated

and compliance with European community’s
stringent RoHs directive mandating restrictions
on hazardous substances in electrical and
electronic equipment have been adhered to

in order to make Philips monitors safe to use
throughout its life cycle.

Congratulations!

This display is designed for both you and the
planet

The display you have just purchased
J.E_E carries the TCO Certified label.

This ensures that your display is
designed, manufactured and tested according to
some of the strictest quality and environmental
requirements in the world. This makes for a
high performance product, designed with the
user in focus that also minimizes the impact on
the climate and our natural environment.

TCO Certified is a third party verified program,
where every product model is tested by an
accredited impartial test laboratory. TCO
Certified represents one of the toughest
certifications for displays worldwide.

Some of the Usability features of the TCO
Certified for displays:

* Visual ergonomics for good image quality
is tested to ensure top performance and
reduce sight and strain problems. Important
parameters are luminance, contrast,
resolution, black level, gamma curve, colour
and luminance uniformity and colour
rendering.

*  Products are tested according to rigorous
safety standards at impartial laboratories.

* Electric and magnetic fields emissions as
low as normal household background
levels.

* Low acoustic noise emissions (when
applicable).

Some of the Environmental features of the
TCO Certified for displays:

* The brand owner demonstrates corporate
social responsibility and has a certified
environmental management system (EMAS
or ISO 14001).

*  Very low energy consumption both in on-
and standby mode minimize climate impact.

* Restrictions on chlorinated and brominated
flame retardants, plasticizers, plastics and
heavy metals such as cadmium, mercury
and lead (RoHS compliance).

* Both product and product packaging is
prepared for recycling.

* The brand owner offers take-back options.

The requirements can be downloaded from our
web site. The requirements included in this label
have been developed by TCO Development

in co-operation with scientists, experts, users as
well as manufacturers all over the world. Since
the end of the 1980s TCO has been involved

in influencing the development of IT equipment
in a more user-friendly direction. Our labeling
system started with displays in 1992 and is

now requested by users and [T-manufacturers
all over the world. About 50% of all displays
worldwide are TCO certified.

For more information, please visit:
www.tcodevelopment.com

TCOF1058 TCO Document,Ver. 2.1

I[u Technology for you and the planet
CERTIFIED
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EPEAT
(www.epeat.net)
X, “The EPEAT (Electronic
QQ Product Environmental
<2
a Assessment Tool) program

evaluates computer
desktops, laptops, and monitors based on
51 environmental criteria developed through
an extensive stakeholder consensus process
supported by US EPA.

EPEAT system helps purchasers in the public
and private sectors evaluate, compare and
select desktop computers, notebooks and
monitors based on their environmental
attributes. EPEAT also provides a clear and
consistent set of performance criteria for the
design of products, and provides an opportunity
for manufacturers to secure market recognition
for efforts to reduce the environmental impact
of its products.”

Benefits of EPEAT

Reduce use of primary materials
Reduce use of toxic materials

Avoid the disposal of hazardous waste EPEAT'S
requirement that all registered products meet
ENERGY STAR'’s energy efficiency specifications,
means that these products will consume less
energy throughout their life.
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CE Declaration of Conformity

This product is in conformity with the following
standards

*  EN60950-1:2006 (Safety requirement of
Information Technology Equipment).

»  EN55022:2006 (Radio Disturbance
requirement of Information Technology
Equipment).

*  EN55024:1998+A1:2001+A2:2003
(Immunity requirement of Information
Technology Equipment).

*  EN61000-3-2:2006 (Limits for Harmonic
Current Emission).

+ EN61000-3-3:1995+A1:2001+A2:2005
(Limitation of Voltage Fluctuation and
Flicker) following provisions of directives
applicable.

* 2006/95/EC (Low Voltage Directive).

»  2004/108/EC (EMC Directive).

» 2005/32/EC (EuP Directive, EC No.
1275/2008 mplementing Directive
for Standby and Off mode power
consumption) and is produced by a
manufacturing organization on 1SO9000
level.

The product also comply with the following

standards

* 1S09241-307:2008 (Ergonomic
requirement, Analysis and compliance test
methods for electronic visual displays).

e GS EK1-2000:2009 (GS mark requirement).

»  prEN50279:1998 (Low Frequency Electric
and Magnetic fields for Visual Display).

e MPR-II (MPR:1990:8/1990:10 Low
Frequency Electric and Magnetic fields).

*  TCO CERTIFIED (Requirement for
Environment Labeling of Ergonomics,
Energy, Ecology and Emission, TCO: Swedish
Confederation of Professional Employees)
for TCO versions.
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Energy Star Declaration

(Www.energystar.gov)

h As an ENERGY STAR® Partner, we

have determined that this product
meets the ENERGY STAR”
guidelines for energy efficiency.

e Note

We recommend you switch off the monitor
when it is not in use for a long time.

Federal Communications Commission (FCC)
Notice (U.S. Only)

€ This equipment has been tested and found
to comply with the limits for a Class B digital
device, pursuant to Part 15 of the FCC
Rules. These limits are designed to provide
reasonable protection against harmful
interference in a residential installation.
This equipment generates, uses and can
radiate radio frequency energy and, if not
installed and used in accordance with the
instructions, may cause harmful interference
to radio communications.

However, there is no guarantee that
interference will not occur in a particular
installation. If this equipment does cause
harmful interference to radio or television
reception, which can be determined by
turning the equipment off and on, the
user is encouraged to try to correct

the interference by one or more of the
following measures:

* Reorient or relocate the receiving antenna.

* Increase the separation between the
equipment and receiver.

»  Connect the equipment into an outlet on
a circuit different from that to which the
receiver is connected.

*  Consult the dealer or an experienced
radio/TV technician for help.

22

@ Changes or modifications not expressly
approved by the party responsible for
compliance could void the user's authority
to operate the equipment.

Use only RF shielded cable that was supplied
with the monitor when connecting this monitor
to a computer device.

To prevent damage which may result in fire or
shock hazard, do not expose this appliance to
rain or excessive moisture.

THIS CLASS B DIGITAL APPARATUS MEETS
ALL REQUIREMENTS OF THE CANADIAN
INTERFERENCE-CAUSING EQUIPMENT
REGULATIONS.

FCC Declaration of Conformity

Declaration of Conformity for Products Marked
with FCC Logo,

United States Only

FC

This device complies with Part 15 of the FCC
Rules. Operation is subject to the following
two conditions: (1) this device may not cause
harmful interference, and (2) this device must
accept any interference received, including
interference that may cause undesired
operation.

Commission Federale de la Communication
(FCC Declaration)

© Cet équipement a été testé et déclaré
conforme auxlimites des appareils
numériques de class B,aux termes de l'article
15 Des regles de la FCC. Ces limites sont
congues de facon a fourir une protection
raisonnable contre les interférences nuisibles
dans le cadre d'une installation résidentielle.

CET appareil produit, utilise et peut émettre
des hyperfréquences qui, si I'appareil n'est
pas installé et utilisé selon les consignes
données, peuvent causer des interférences
nuisibles aux communications radio.
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Cependant, rien ne peut garantir |'absence
d'interférences dans le cadre d'une
installation particuliere. Si cet appareil est
la cause d'interférences nuisibles pour

la réception des signaux de radio ou de
télévision, ce qui peut étre décelé en
fermant I'équipement, puis en le remettant
en fonction, |'utilisateur pourrait essayer de
corriger la situation en prenant les mesures
suivantes:

* Réorienter ou déplacer I'antenne de
réception.

* Augmenter la distance entre I'équipement
et le récepteur.

*  Brancher I'équipement sur un autre circuit
que celui utilisé par le récepteur

¢ Demander l'aide du marchand ou d'un
technicien chevronné en radio/télévision.

@ Toutes modifications n'ayant pas recu
I'approbation des services compétents
en matiére de conformité est susceptible
d'interdire a l'utilisateur I'usage du présent
équipement.

N'utiliser que des cables RF armés pour
les connections avec des ordinateurs ou
périphériques.

CET APPAREIL NUMERIQUE DE LA CLASSE
B RESPECTE TOUTES LES EXIGENCES DU
REGLEMENT SUR LE MATERIEL BROUILLEUR
DU CANADA.

EN 55022 Compliance (Czech Republic Only)

“This davice belongs to catagory B devices as described in EN 55022, unless it is spacii-
cally stated that it i a Class A devics on the epeciication labal. The following applies to
devices in Class A of EN 55022 (radius of protection up 1o 30 meters). The user of the
davics is obliged to take all staps necessary to remove sources of interfarence 1o tals-
communication or other devicas.

Pokud nani na typovém &thu potstaie uvedena, #. spedé do do tidy A podie EN 55022,

do tfidy B podie EN 55022. Pro zafizen zafazend do tiidy A (chranné
pésma 30m) podle EN 55022 platl nésledujicl. Dojde-li k rullan! telskomunikataich nebo
finjich zafizeni e uivatal povinnen provést takova opatfgni, sty nen odstranl

Polish Center for Testing and Certification
Notice

The equipment should draw power from a
socket with an attached protection circuit (a
three-prong socket). All equipment that works
together (computer, monitor, printer, and so
on) should have the same power supply source.

The phasing conductor of the room's electrical
installation should have a reserve short-circuit
protection device in the form of a fuse with a
nominal value no larger than 16 amperes (A).

To completely switch off the equipment, the
power supply cable must be removed from the
power supply socket, which should be located
near the equipment and easily accessible.

A protection mark "B" confirms that the
equipment is in compliance with the protection
usage requirements of standards PN-93/
T-42107 and PN-89/E-06251.

Wymagania Polskiege Centrum Badan i Certyfikacji

Uzpedzenie powiano byt rasilane z poiasds 2 preylaceonym obwodem ochronsym (grisedo &

Katkiem). Wapdipracuiaee 22 soby ufzadzenia (Komputer, monitor, drukarka) pointy bye msilane
& topo samego dridla.

Instalacja elektryrma pomiesrcaenia powinna z
proeel warciami, w pestaci bezpiecznika o vt

maé w przeworksie fzowym rezecvowa achrang
marmienavwe] e wicksej ni 164 (amperiw).

W el catkowitego wybserenia urzadzenia 2 siect zasilania, nalezy wyjné wivceks kabla
easilajacega = proazdka, kiare pewinno ssidowad s w pobliz urmJJanmllnr atwd dosiepne.

Fnak beaplocaefsrwa "B” potwierdzs zpodnodd urzsdzenia 2 wynspanian hezplecaeistua
wiytkowaitia zawartyini w PR-ALTA2T07 | P-4 L6

Pozostale instrukcje begpieczensiwa

Nie maleiy uiywad wiyceek adapterowych lub usuwal kolka abwodu ochromnego 2 wiycek,
Jereli kseene jest sy peadluzsczs to sulezy uiy preoilugaces 3-ylowegn 2

System kempaterawy mluy sabespicciyd prod naghymi, chvilow
i napsecin, uivwijac eliminalors preepied, urzadrenia dopasam
berakliceniowepa rodia rasilania

erostami lub spad-
uh

Dl upewnid sie. ahy nit it ezalo 15 kablach sysiemu kompuierowege. acaz aby kable wie
200 ¥ se ikna byloby i i nadeptywad lub potykal sl o e,

T e p————

kempuserowegs, glyi moke
—— wewmgirznych.
dowat sig 2 dals od g
Tacyjnych. Nulezy un " i
karnpaler oriz umiescaania kamputers w ciasym migjse bez mapiwobc
etz wokdl niego.

erkakacii powi-
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6. Informace o regulaci

North Europe (Nordic Countries) Information

Placering/Ventilation

VARNING:

FORSAKRA DIG OM ATT HUVUDBRYTARE
OCH UTTAG AR LATATKOMLIGA, NAR
DU STALLER DIN UTRUSTNING PAPLATS,

Placering/Ventilation

ADVARSEL:

SORG VED PLACERINGEN FOR, AT
NETLEDNINGENS STIK OG STIKKONTAKT
ER NEMT TILG/ANGELIGE.

Paikka/llmankierto

VAROITUS:

SIJOITA LAITE SITEN, ETTA VERKKOJOHTO
VOIDAAN TARVITTAESSA HELPOSTI
IRROTTAA PISTORASIASTA.

Plassering/Ventilasjon

ADVARSEL:

NAR DETTE UTSTYRET PLASSERES, MA
DU PASSE PA AT KONTAKTENE FOR
ST@MTILF@RSEL ER LETTE A NA.

BSMI Notice (Taiwan Only)
RHAZHERERZIEE |

Ergonomie Hinweis (nur Deutschland)

Der von uns gelieferte Farbmonitor entspricht
den in der "Verordnung Uber den Schutz vor
Schiden durch Rontgenstrahlen" festgelegten
Vorschriften.

Auf der Rickwand des Gerites befindet sich
ein Aufkleber, der auf die Unbedenklichkeit der
Inbetriebnahme hinweist, da die Vorschriften
Uber die Bauart von Stérstrahlern nach Anlage
a5 Abs. 4 der Réntgenverordnung erfilit
sind.

Damit Ihr Monitor immer den in der Zulassung
geforderten Werten entspricht, ist darauf zu
achten, dal3

1. Reparaturen nur durch Fachpersonal
durchgefiihrt werden.
2. nur original-Ersatzteile verwendet werden.

bei Ersatz der Bildréhre nur eine
bauartgleiche eingebaut wird.

Aus ergonomischen Griinden wird empfohlen,
die Grundfarben Blau und Rot nicht auf
dunklem Untergrund zu verwenden (schlechte
Lesbarkeit und erhéhte Augenbelastung bei zu
geringem Zeichenkontrast waren die Folge).
Der arbeitsplatzbezogene Schalldruckpegel
nach DIN 45 635 betrdgt 70dB (A) oder
weniger.

) ACHTUNG: BEIM AUFSTELLEN
DIESES GERATES DARAUF
ACHTEN, DAB NETZSTECKER UND
NETZKABELANSCHLUB LEICHT
ZUGANGLICH SIND.
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China RoHS

The People's Republic of China released a
regulation called "Management Methods for
Controlling Pollution by Electronic Information
Products" or commonly referred to as China
RoHS. All products including CRT and Monitor
which are produced and sold for China market
have to meet China RoHS request.
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7. Péce o zakazniky a zaruka

7.1 Postup pri vadnych pixelech
plochého panelu spolecnosti
Philips

Spolecnost Philips se snazi doddvat vyrobky
vyrobnich postup( vyroby v tomto odvétvi a
prosazuje prisnou kontrolu kvality. Defekttim
obrazovych bodd nebo dil¢ich obrazovych
bodl u panelt TFT LCD, které se pouzivajf
pro ploché monitory, se nicméné nékdy neda
zabranit. Zadny vyrobce nemuize zarudit, ze
vsechny panely budou bez defektd obrazovych
bodd, ale spole¢nost Philips zarucuje, ze kazdy
monitor s nepfijatelinym poctem defektl bude
v rdmci zdruky opraven nebo vymeénén.Tento
text vysvétluje jednotlivé druhy defektd na
pixelech a urcuje Unosnou Uroveri chybovosti
pro kazdy druh. Aby bylo mozné uplatnit zaru¢ni
opravu nebo vyménu, musi pocet defektnich
obrazovych bodd panelu TFT LCD presdhnout
tuto Uroveri dnosnosti. Na monitoru napriklad
nesmf byt vice defektnich dil¢ich obrazovych
bodd nez 0,0004 %. Ddle, protoze nékteré typy
kombinaci vad pixeltl jsou lépe postrehnutelné
nez jiné, stanovuje pro né spolecnost Philips
jesté vetsi ndroky na kvalitu. Tato norma se
dodrzuje celosvetove.

subpixely subpixely subpixely

v
pixely

Pixely a subpixely

Pixel, neboli obrazovkovy bod, se sklddd ze tif
subpixell v zdkladnich barvdch cervené, zelené a
modré. Kdyz je mnoho pixeld pohromadeé, tvorf
obraz. Kdyz viechny subpixely urcitého pixelu
svitf, jevi se tyto tri subpixely spolecné jako
jediny bily pixel. Kdyz jsou viechny tmavé, jevi

se tyto tfi subpixely jako jeden cerny pixel. Dalsf
kombinace rozsvicenych a tmavych subpixell se
jevi jako pixely rdznych barev.

Druhy pixelovych vad

Vady pixell a subpixeld se na obrazovce
projevuji riiznymi zpusoby. Existujf dva druhy vad
pixelu a v rdmci téchto druhu je nékolik typd
subpixelovych vad.

Defekty svétlych bodu

Defekty svétlych bodl se projevuji jako
obrazové body nebo dil¢l obrazové body, které
vzdy svitl nebo jsou 'aktivni'. Svétly bod je dil¢f
obrazovy bod, ktery vystupuje z obrazovky, kdyz
je na monitoru zobrazena tmava plocha. Existujf
nasledujici typy defektl svétlych bodU:

Jeden cerveny, zeleny nebo modry subpixel.

¢

Dva soundlezicl subpixely:

- Cerveny + modry = fialovy

- Cerveny + zeleny = Zluty

- zeleny + modry = svétle modry

Tri soundlezici rozsvicené subpixely (jeden bily
pixel).
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€ Poznamka

Cerveny nebo modry svétly bod musf byt o
vice nez 50 procent jasnéjsi, nez sousedni body;
zeleny svétly bod je o 30 procent jasnéjsi, nez
sousedni body.

Defekty tmavych bodl

Defekty tmavych bodu se projevuif jako
obrazové body nebo dil¢f obrazové body, které
nikdy nesviti nebo jsou ,,neaktivni'. Tmavy bod je
dil¢i obrazovy bod, ktery vystupuje z obrazovky,
kdyz je na monitoru zobrazena svétld plocha.

Existuji ndsledujicl typy defektd tmavych bodl:

Vzdalenost pixelovych vad

Protoze vady pixell a subpixell stejného

typu, které se vyskytuji blizko sebe, mohou byt
patrnéjsi, urcuje spolecnost Philips i tolerance na
vzdélenost vad pixeld.

Tolerance vad pixeld

Aby bylo mozné uplatnit opravu nebo vyménu
kvadli defektnim obrazovym bodim v zaru¢nf
dobé, musi panel TFT LCD plochého monitoru
Philips vykazovat defekty obrazovych bodl
nebo dil¢ich obrazovych bodu, které prekracujf
tolerance uvedené v ndsledujicich tabulkéch.

KAZY JASNYCH BODU

PRIJATELNY POCET VAD

1 trvale svitici bod 3
2 sousedni trvale svitici body 1
3 sousedn( trvale svitici body (nebo 1 trvale svitici bily bod) 0
Vzddlenost mezi dvéma kazy jasnych bodi* >15 mm
Celkovy pocet kazl jasnych bodd viech typl 3

KAZY CERNYCH BODU
1 tmavy bod

PRIJATELNY POCET VAD
5 nebo méné

2 sousedni tmavé body

2 nebo méné

3 sousedni tmavé body

0

Vzddlenost mezi dvéma kazy cemych bodi*

>15 mm

Celkovy pocet kazt ¢ernych bodd viech typl

5 nebo méné

KAZy bodu celkem

Celkovy pocet kazt jasnych nebo ¢ernych bodut viech typl

PRIJATELNY POCET VAD
5 nebo méné

© Poznimka

1. 1 nebo 2 sousedni vadné body (1 barva) = 1 vadny bod
2. Tento monitor je kompatibilni se standardem ISO 9241-307. ( ISO 9241-307: Ergonimicky
pozadavek, analyza a metody testovdni shody pro elektronicka zobrazovacf zarizen)
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7.2 Péce o zakazniky & zaruka

Podrobné informace o zdruce a poZadavku na dodatecnou podporu platné pro vasi oblast najdete na
webu www.philips.com/support. Rovnéz mizete kontaktovat mistni centrum péce o zdkazniky na nize

uvedenych telefonnich &islech.

Kontaktni informace pro oblast ZAPADNI EVROPY:

A

Germany Siemens &S +49 01803 386 853 €009
United Kingdom Invec Scotland +44 0207 949 0069 Local call tariff
Ireland Invec Scotland +353 01 601 1161 Local call tariff
Spain Eatsa Spain +34 902 888 785 €010
Finland A-novo +358 09 2290 1908 Local call tariff
France A-novo +33 082161 1658 € 0,09
Greece Allman Hellas +30 00800 3122 1223 Free of charge
Italy A-novo +39 840 320 041 €0,08
Netherlands E Care +31 0900 0400 063 €010
Denmark A-novo +45 3525 8761 Local call tariff
Norway A-novo +47 2270 8250 Local call tariff
Sweden A-novo +46 08 632 0016 Local call tariff
Poland Zolter +48 0223491505 Local call tariff
Austria Siemens &S +43 0810 000206 €007
Belgium E Care +32 078 250851 € 0,06
Luxembourg E Care +352 26 84 30 00 Local call tariff
Portugal Eatsa Spain +351 2 1359 1440 Local call tariff
Switzerland A-novo +41 02 2310 2116 Local call tariff
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Kontaktni informace pro oblast STREDNI A VYCHODNI EVROPY:

elefo e o A

Belarus NA IBA +375 17 217 3386
Bulgaria NA LAN Service +359 2 960 2360
Croatia NA Renoprom +385 1 333 0974
Estonia NA FUJITSU +372 6519900
Latvia NA “ServiceNet LV" Ltd. +371 7460399
Lithuania NA UAB "Servicenet" +370 7400088
Romania NA Blue Ridge Intl. +40 21 2101969
woroe fegm NA Kim Tec doo. +381 11 20 70 684
Slovenia NA PC H.and +386 1 530 08 24
NA Comel +380 562320045
Haine NA E‘(’)ﬁ;fﬂ‘;mce +38 044 245 73 31
. NA CPS +7 (495) 645 6746 (for repair)
NA CEEE Partners +7 (495) 645 3010 (for sales)
Slovakia NA Datalan Service +421 2 49207155
Turkey NA Techpro +90 212 444 4 832
Czech Rep. NA Asupport 800 100 697
Hungary NA Serware , +36 1 2426331
NA Profi Service +36 1 814 8080

Kontaktni informace pro oblast LATINSKE AMERIKY:

Zemé

Brazil

Argentina

Telefonni stredisko

Vermont

Cislo zakaznické péce
0800-7254101

0800 3330 856

Kontaktni informace pro Cinu:

Cina

Cislo zékaznické péce: 4008 800 008

Kontaktni informace pro SEVERNI AMERIKU:

USA.

TOS Teleplan

(877) 835-1838

Canada

Supercom Supercom

(800) 479-6696
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Kontaktni informace pro oblast APMEA:

Australia NA AGOS NETWORK PTY LTD | 1300 360 386
New Zealand NA Visual Group Ltd. 0800 657447
. Hong Kong:Tel: +852 2619 9639
Hong Kong / Macau | NA Smart Pixels Technology Ltd. Macau:Tel: (853)-0800-987
. Tel: 1 800 425 6396
India NA REDINGTON INDIA LTD SMS: PHILIPS 1o 56477
Ind ) NA PT. Gadingsari elektronika Tel: 62 21 75909053, 75909056,
Aeonesia Prima 7511530
South Korea NA PCS One Korea Ltd. 080-600-6600
: After Market Solutions (CE)
Malaysia NA Sdn Bhd 603 7953 3370
Pakistan NA Philips Consumer Service (9221) 2737411-16
Philips Electronics Singapore
Singapore NA Pte Ltd (Philips Consumer (65) 6882 3999
Care Center)
PCCW
Taiwan Teleservices FETEC.CO 0800-231-099
Taiwan
Thailand NA s Computer System €O+ (46 934-5498
South Africa NA Sylvara Technologies Pty Ltd | 086 0000 888
Unllted Arab NA AL SHAHD COMPUTER 00971 4 2276525
Emirates LLC
Israel NA Eastronics LTD 1-800-567000
: : +84 8 38248007 Ho Chi Minh City
Vietnam NA EZTmsear:'cig‘format'c +84 5113.562666 Danang City
Py +84 5113562666 Can tho Province
- . (02) 633-4533 to 34,
Philippines NA Glee Electronics, Inc. (02) 637-6559 to 60
Sri Lanka NA no d!strlbutor and/or service
provider currently
Bangladesh NA Distributor: Computer Source | 880-2-9141747, 9127592
g Ltd (warranty buy-out) 880-2-8128848 / 52
Nepal NA Distributor: Syakar Co. Ltd 977-1-4222395
(warranty buy-out)
Distributor: Neat Technology
Cambodia NA Pte Ltd (Singapore) (warranty | 855-023-999992
buy-out)
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8. Odstranovani problému a ¢asté dotazy

8. Odstranovani probléma a
Casté dotazy

8.1 Odstranovani problému

Na této strance jsou uvedeny problémy,
které mlZe odstranit uZivatel. Pokud problém
pretrvava i po vyzkousenf téchto resent,
kontaktujte zastupce sluzeb pro zdkazniky
spolecnosti Philips.

El Bé&iné problémy

Zadny obraz (indikitor LED napéjeni nesviti)

»  Zkontrolujte, zda je napdjeci kabel pripojen
k elektrické zdsuvce a do zadnf ¢asti
monitoru.

*  Nejdrive zkontrolujte, zda se vypinac na
prednf strané monitoru nachdzf ve OFF
(VYPNUTE) poloze a stisknéte jej do ON
(ZAPNUTE) polohy.

Zadny obraz (indikator LED napajeni je bily)
Zkontrolujte, zda je zapnuty pocitac.

»  Zkontrolujte, zda je kabel signdlu rddné
pripojen l< poél’taéi.

»  Zkontrolujte, zda nejsou ohnuté koliky na
pripojovaci strané kabelu monitoru. Pokud
ano, opravte nebo vymérite kabel.

*  Pravdépodobné je aktivovdna funkce rizenf
spotreby

Obrazovka rika

Attention

Check cable connection

»  Zkontrolujte, zda je kabel monitoru rddné
pripojen k pocitaci. (Rovnéz viz Strucnd
prirucka).

e Zkontrolujte, zda nejsou ohnuté koliky
kabelu monitoru.

»  Zkontrolujte, zda je zapnuty pocftac.

Tlaéitko AUTO nefunguje
* Automatickd funkce je pouzitelnd pouze
v rezimu VGA-analogovy. Pokud vysledek
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nenf uspokojivy, mizete provést rucnf
Upravy prostrednictvim nabidky OSD.

€& Poznimka
Automatickd funkce neni pouzitelnd v
rezimu DVI-digitdIni, protoZze je zbytecnd.

Viditelné znamky koure nebo jiskreni

*  Neprovéddéjte zddné kroky pro odstrariovénf
problémd

*  Pro zajisténi bezpecnosti ihned odpojte
monitor od zdroje napdjenf

* |hned kontaktujte zdstupce sluzeb pro
zdkazniky spolecnosti Philips.

El Problémy se zobrazenim

Obraz neni vystredén

»  Upravte polohu obrazu pomocf funkce
,Auto” v hlavnich ovlddacich prvcich OSD.

*  Upravte polohu obrazu pomoci poloZzek
Phase/Clock (Faze/frekvence) v casti Setup
(Nastaveni) v Hlavni ovlddaci prvky OSD.
Tato funkce je platnd pouze v rezimu VGA.

Obraz se chvéje na obrazovce

»  Zkontrolujte, zda je kabel signdlu rddné a
bezpecné pripojen ke grafické desce nebo k
pocitaci.

Dochazi ke svislému blikani

»  Upravte polohu obrazu pomoci funkce
,Auto” v hlavnich ovldadacich prvcich OSD.

*  Omezte svislé pruhy pomoci polozek
Phase/Clock (Faze/frekvence) v &asti Setup
(Nastaveni) v Hlavni ovlddaci prvky OSD.
Tato funkce je platnd pouze v rezimu VGA.

Dochazi k vodorovnému blikani

u

*  Upravte polohu obrazu pomocf funkce
,Auto” v hlavnich ovldadacich prvcich OSD.
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*  Omezte svislé pruhy pomoci polozek
Phase/Clock (Féze/frekvence) v ¢asti Setup
(Nastaveni) v Hlavni ovlddaci prvky OSD.
Tato funkce je platnd pouze v rezimu VGA.

Obraz je rozmazany, nevyrazny nebo prilis
tmavy
*  Upravte kontrast a jas na obrazovce OSD.

,Dosvit", ,,vypéleni* nebo ,,zobrazeni duchi*

zUstane po vypnuti napajeni.

*  Dlouhodobé neprerusované zobrazenf
nehybného nebo statického obrazu mize
zpUsobit ,,vypdleni* obrazovky, rovnéz
zndmé jako ,,dosvit" nebo ,,zobrazenf
duchd”. ,Vypéleni*, ,,dosvit" nebo
,,zobrazeni duchd" je dobre zndmy jev
u technologie paneld LCD. V mnoha
pripadech ,,vypdlen(”, , dosvit"* nebo
,,zobrazeni duchd" postupné zmizf po urcité
dobé mimo provoz.

*  Pred ponechdnim monitoru bez dozoru
vzdy aktivujte spori¢ obrazovky.

* Bude-li na vaSem monitoru LCD zobrazen
nemeénici se staticky obsah, vzdy aktivujte
aplikaci pro pravidelnou obnovu obrazovky.

»  Vézné priznaky ,vypdleni”, , dosvitu" nebo
,,zobrazenf duchd' nezmizf a nelze je
opravit. Na vySe uvedené poskozeni se
nevztahuje zdruka.

Obraz je zdeformovany. Text je nejasny nebo

rozmazany.

* Nastavte rozlideni zobrazenf pocitace na
stejny rezim, v jakém se nachdzl doporucené
nativni rozliSenf obrazovky monitoru.

Na obrazovce se objevuji zelené, cervené,

modré, tmavé a bilé tecky

e Zbyvajicl body jsou normadlni viastnostf
tekutych krystald pouzivanych souc¢asnou
technologil. Dalsi podrobnosti viz pravidla
pro obrazové body.

Svétlo indikatoru ,,napajeni* je prilis silné a

rusi

* MdZete nastavit intenzitu svétla indikdtoru
,napdjeni v ¢asti Power LED (Indikdtor
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LED napdjeni) v ¢dsti Setup (Nastaven)
v Hlavni ovlddaci prvky nabidky OSD.

Potrebujete-li dalsi pomoc, viz seznam
Informacni strediska pro zdkazniky a kontaktujte
zéstupce sluzeb pro zdkazniky spolecnosti
Philips.

8.2 SmartControl Lite — casté dotazy

OTAZKA 1: Zménil jsem monitor v
pocitaci za jiny a technologie
SmartControl Lite se stala
nepouzitelnou, co mam délat?
Restartujte pocitac a zjistéte, zda
technologie SmartControl Lite
funguje.V opacném pripadé bude
tfeba odebrat a znovu nainstalovat
SmartControl Lite, aby bylo
zajisteno, Ze je nainstalovdn
spravny ovladac.
OTAZKA 2: Technologie SmartControl Lite
drive dobre fungovala, ale nyni
nefunguje, co mam délat?

Odpoveéd:

Odpovéd:  Pokud byly provedena nésledujici
kroky, bude pravdépodobné
nutné znovu nainstalovat ovladac
monitoru.

* Poutzijte jiny graficky adaptér videa

*  Zaktualizujte ovladac videa

+  Cinnosti na opera¢nim systému, napiiklad
aktualizace nebo oprava

*  Spust'te sluzbu Aktualizace Windows a
zaktualizujte ovlada¢ monitoru a/nebo videa

*  Operacni systém Windows byl zaveden,
kdyz byl monitor vypnuty nebo odpojeny.

*  Chcete-li ziskat dal3f informace, klepnéte
pravym tlacitkem mysi na My Computer
(Tento pocitac) a klepnéte na Properties
(Vlastnosti) -> Hardware (Hardware) ->
Device Manager (Sprévce zarizen).

* Pokud je pod polozkou Monitor uvedeno
,,Plug and Play Monitor” (Monitor Plug
and Play), je tf'eba provést novou instalaci.
Jednoduse odeberte a znovu nainstalujte
SmartControl Lite.
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OTAZKA 3:

Odpovéd:

OTAZKA 4:

Odpovéd:

OTAZKA 5:

Kdyz po nainstalovani
SmartControl Lite klepnu na
kartu SmartControl Lite, ani po
chvili se nic nezobrazi nebo se
zobrazi zprava o chybé, co se
stalo?

V43 graficky adaptér
pravdépodobné neni kompatibilnf
s technologif SmartControl Lite.
Pokud je vés graficky adaptér mezi
vySe uvedenymi znackami, zkuste
stdhnout nejaktudingsi ovladac
grafického adaptéru z webovych
strdnek prislusného vyrobce.
Nainstalujte ovladac. Odeberte a
znovu nainstalujte SmartControl
Lite.

Pokud presto nefunguje, graficky

adaptér bohuzel nenf podporovdn.

Na webovém serveru spolecnosti
Philips zjistéte, zda je k

dispozici zaktualizovany ovladac
SmartControl Lite.

Po klepnuti na Product
Information (Informace o
produktu) se zobrazi pouze
&asteéné informace, co se stalo?
Pravdépodobné neméte

k dispozici nejaktudlngjsi verzi
ovladace adaptéru grafické karty,
kterd plné podporuje rozhranf
DDC/CI. Pokuste se stahnout
nejaktudlnéjsi ovladac grafického
adaptéru z webovych stranek
prislusného vyrobce. Nainstalujte
ovladac.

Odeberte a znovu nainstalujte
SmartControl Lite.

Attention

Theft mode enabled

Zapomnél jsem svij kéd PIN
pro funkci Theft Deterrence
(zabezpeceni proti kradezi). Co
mam délat?
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Odpovéd:

Servisnf stedisko Philips md
pravo zadat legitimnf identifikaci

a ovéren( pro zjisténi viastnictvi
monitoru.

Upozormiujeme vds, ze funkce
ochrany proti krddeZi je k dispozici
jako snadnd a bezplatnd moznost.
Za spravu ¢isel PIN nese vyhradnf
odpovédnost konkrétni osoba
nebo organizace, kterd ji jmenuje.
Pokud ¢islo PIN zapomenete,
servisni stredisko Philips jej

mUze pro vds znovu nastavit za
nominalni poplatek po ovéren(
vlastnictvi. Upozormiujeme vas,

Ze na tuto &innost se nevztahujf
podminky standardnf zdruky.

8.3 Obecné casté dotazy

OTAZKA 1: Kdyz nainstaluiji sv(ij monitor,

Odpoved:

co mam udélat, kdyz se na
obrazovce zobrazi zprava
,»Cannot display this video
mode* (Tento rezim videa nelze
zobrazit)?

Doporucené rozliseni pro tento
monitor: 1440 x 900 pri 60 Hz.
Odpojte viechny kabely, potom pripojte
pocitac k monitoru, ktery jste pouzili
predtim.

V nabidce Start operacniho systému
Windows vyberte Settings/Control Panel
(Nastaveni/Ovlddaci panely). V okné
Control Panel (Ovlddaci panely) vyberte
ikonu Display (Zobrazeni). Na panelu
Display Control (Zobrazenf — vlastnosti)
vyberte kartu , Settings" (Nastaven). Na
karté nastaven( v poli oznaceném , ,desktop
area" (pracovni plocha) presurite posuvnik
na 1440 x 900 obrazovych bodu.
Klepnéte na ,,Advanced Properties"
(Upreesnit), nastavte polozku Obnovovaci
frekvence na 60 Hz a potom klepnéte na
OK.

Restartujte pocitac a zopakovanim kroku 2
a 3 ovérte, zda je pocitac nastaven na 1440
% 900 pri 60 Hz.
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*  Vypnéte pocitac, odpojte stary monitor a
znowu pripojte monitor LCD Philips.

*  Zapnéte
OTAZKA 2:

Odpovéd:

OTAZKA 3:

Odpovéd:

OTAZKA 4:
Odpovéd:

OTAZKA 5:

Odpovéd:

monitor a potom zapnéte pocitac.

Jaka je doporucena obnovovaci
frekvence monitoru LCD?
Doporucend obnovovaci
frekvence u monitord LCD je 60
Hz. V pripadé jakéhokoli ruseni na
obrazovce ji mizete nastavit na 75
Hz a uvidfte, zda rugenf zmiz.

Co jsou soubory .inf a .icm

na disku CD-ROM? Jak Ize
nainstalovat ovladace (.inf a .icm)?
Jednd se o soubory ovladace
monitoru. Pri instalaci ovladacl
postupujte podle pokynu

v uZivatelské prirucce. Pri

prvni instalaci bude pocitac
pravdépodobné pozadovat
ovladace monitoru (soubory
.infa .icm) nebo disk s ovladadi.
Postupujte podle pokynd a

vlozte (doprovodny disk CD-
ROM), ktery je soucdsti této sady.
Ovladace monitoru (soubory
.inf a .icm) budou nainstalovany
automaticky.

Jak mam upravit rozliseni?
Dostupnd rozlisenf urcuje grafickd
karta/ovladac grafiky a monitor.
PoZadované rozliSenf mizete
vybrat v ¢ésti Ovlddaci panely
systému Windows® v &sti
,Zobrazen( - vlastnosti*.

Co kdyz se béhem

nastaveni monitoru ztratim
prostrednictvim nabidky OSD?
Jednoduse stisknéte tlacitko OK a
potom volbou ,,Reset” (Obnovit)
obnovte viechna pdvodnf
nastaven( vyrobce.

OTAZKA 6: Je obrazovka LCD odolné proti

poskrabani?

Odpovéd:  Obecné se doporucuje

nevystavovat povrch panelu
nadmémym uderdm a chrdnit

jej pred ostrymi nebo tupymi
predméty. Pri manipulaci

s monitorem nevyvijejte na povrch
panelu zddny tlak ani silu. Mohlo
by to negativné ovlivnit vase
zarucni podminky.

OTAZKA 7: Jak Ize ¢istit povrch monitoru

LCD?

Odpovéd:  Pro bézné cisténi poutzijte Cisty

a mékky hadrik. Pro dikladné
Cisténl pouzijte izopropyl
alkohol. Nepouzivejte zddna jind
rozpoustédla, jako etylalkohol,
etanol, aceton, hexan atd.

OTAZKA 8: Lze ménit nastaveni barev

monitoru?

Odpovéd:  Ano, nastaveni barev mizete
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zménit prostrrednictvim nabidky
OSD podle nésledujicich krokd:

Stisknutim tlacftka ,,OK" zobrazte nabidku
OSsD.
Stisknutim tlacitka ,,Down Arrow" (Sipka
dold) vyberte volbu ,,Color* (Barva)
a stisknutim tlacitka ,, OK" prejdéte na
nastaven( barev. K dispozici jsou tfi nastaven(
(viz niZe).
1. Color Temperature (Teplota barev):
k dispozici je dvou nastaveni: 6500K
a 9300K. Pri nastaveni v rozsahu
6500K vypadaji barvy na panelu teplé s
Cervenobilym barevnym tdnem, zatimco
pri nastaven( teploty 9300K vypadaji
barvy na panelu studené s modrobilym
barevnym ténem.

2. sRGB: standard pro zajisténi spravné
prenosu barev mezi riiznymi zar{zenimi
(napr. digitalni fotoapardty, monitory,
tiskdrny, skenery atd.)

3. User Define (Uzivatelské): uzivatel si
muze zvolit vlastni nastaven( barev
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upravenim cervené, zelené a modré
slozky.

€& Poznamka:

Mérenf svétla barvy, které vyzaruje predmét

pri zahrfvani. Toto mérenf je vyjaddreno v
absolutnim méritku (stupné Kelvina). Nizsf
teploty Kelvina, napriklad 2004 K, jsou cervené;
vy3si teploty, jako napriklad 9300 K, jsou modré.
Neutrdlni teplota je bild pri 6504 K.

OTAZKA 9:  Lze pfipojit tento monitor LCD
k libovolnému pocitaci, pracovni
stanici nebo pocitaci Mac?

Odpovéd: Ano.Viechny monitory LCD

Philips jsou pIné kompatibilni se
standardnimi pocftaci, pocitaci
Mac a pracovnimi stanicemi. Pro
pripojeni monitoru k systému
Mac mlze byt zapotrebf
kabelovy adaptér: Dal3f informace

zéstupce Philips.

OTAZKA 10: Jsou monitory Philips LCD
vybaveny technologii Plug-and-
Play?

Ano, tyto monitory jsou
kompatibiln s technologif Plug-
and-Play v operacnim systému
Windows 7,Vista, XP NT, Mac
OSX a Linux.

Odpovéd:

OTAZKA 11: Co znamena Ipéni obrazu,
vypaleni obrazu, dosvit nebo
,,duch* v souvislosti s panely
LCD?

Dlouhodobé neprerusované
zobrazeni nehybného nebo
statického obrazu muze zpUsobit
,vypaleni" obrazovky, rovnéz
znamé jako ,,dosvit" nebo
,zobrazeni duch("., Vypdlenf",
,,dosvit' nebo ,,zobrazenf
duchl'" je dobre znamy jev

u technologie panelt LCD.V
mnoha pripadech ,vypalen(",
,dosvit' nebo ,,zobrazeni duchd'

Odpovéd:
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postupné zmizi po urcité dobé
mimo provoz.
Pred ponechdnim monitoru bez
dozoru vzdy aktivujte spori¢
obrazovky.
Bude-li na vasem monitoru LCD
zobrazen neménici se staticky
obsah, vzdy aktivujte aplikaci pro
pravidelnou obnovu obrazovky.
D Vystraha
Vdzné priznaky ,vypdleni, ,dosvitu" nebo
,,zobrazenf duchd'" nezmizf a nelze je opravit.
Na vySe uvedené poskozen( se nevztahuje
zdruka.

OTAZKA 12: Pro¢ se na displeji nezobrazuje
ostry text a pro¢ maji
zobrazené znaky zubaté okraje?
V4s monitor nejlépe pracuje pri
svém nativnim rozlisenf 1440

% 900 pri 60 Hz. Pouzivejte
toto rozlisenf pro dosazenf
optimdlniho zobrazen.

Odpovéd:
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